COBBLESTONE SOFTWARE

AUTO EXTRACT DOCUMENTS TEXT AND FIELDS

Contract Insight® Enterprise Auto-Extract

With CobbleStone Contract Insight® Enterprise, managing contracts just got easier with the
auto-extract feature. CobbleStone Contract Management Software Enterprise Edition provides
better usability via the ‘add contract from file’ feature found in earlier versions. Below are some
features that help your team add contracts faster with a file auto-extract feature. [Note: this
feature is not the same as the bulk auto-extract feature that can traverse through a directory of
files in a folder OCR the file and extract text based on rules and auto import the data into the
Enterprise system)]. This ‘in-application’ feature is built to help contract professionals add
contracts to the system (on an ongoing basis) faster with an auto extract feature and when
coupled with the existing workflow (field monitoring), the system can auto validate field and
clause data and route workflow tasks based on set conditions).

CONSULTING AGREEMENT Country/Postal |

Code:

This Consulting Agreement (the "Agreement”) is made and entered into October 8, 2018 Sove Company & Refresh |_keved data below will need o be re-keyed in
(the "Effective Datc™) and expires on October &, 201% by and between CobbleStone Softwarc, a
S- corporation duly organized under law and having an usual place of business at California
(hereinafier referred 1o as the “Company”) and ABC Company with offices (hereinafier referred
o as the "Consultant").

Effective Date
WHEREAS, the Company wishes to engage the Consultant to provide the services

described herein and Consultant agrees (o provide the services for the compensation and 10/8/2018
otherwise in may not assigned accordance with the terms and conditions contained in this
Agreement,
NOW THEREFORE, in consideration of the foregoing, and for other good and valuable Exp"qhon D(“e
consideration, the receipt and sufficiency of which are hereby acknowledged. accepted and
agreed 1o, the Company and the Consultant, intending to be legally bound, agree to the terms set 10/8/2019)
forth helow.
L. TERM. Commencing as of the Effective Date, and continuing for a period of Two (2) .
yeurs (the “Term™), unless earlier terminated pursuant to Article 4 hereof, the Consultant agrees N01|f‘[ DUYS
that heishe will serve as a consultant to the Company. This Agreement may be renewed or
extended for any period as may be agreed by the parties. &0

1 DUTIES AND SERVICES.

Contract Insight® Auto Extract Text and Field Mapping

CobbleStone Contract Insight® Enterprise includes an improved feature related to the existing
'add contract from file’ feature found under the ‘Contracts’ top menu.

Contract Insight® Enterprise provides better contract processing and control with the ‘add
contract from file’ feature found in earlier versions. This includes the ability to map out areas of
standard formatted contract files related to newly added contract records (via the Contracts |
'Add Contract from File’ menu). This feature offers auto (configured) extract fields & sections of
the document to Contract Fields on the Contract Record and detects if the file is a non OCRed
PDF file, the system will enable a PDF OCR feature (note: OCR results & speed may vary) (in-
system auto extract works well with MS Word Documents and PDF Documents). Prior to using
this auto extract feature, the rules for the auto extract must be set up by an application
configuration user (System Admin User) via the Manage/Setup | Auto Extract Settings menu
(image seen below).
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Simple Configuration Example
Prior to using this auto extract feature, the rules for the auto extract must be set up by an
application configuration user (System Admin User) via the Manage/Setup | Auto Extract
Settings menu (image seen below).

Setup | Help Log Out

Employees »
Field Manager r
Reference Data »
Application Configuration >

Contract Occurrence

Avuto Extract Settings
Document Templates »
Manage Security Groups

The System Admin User should configure these auto extract rules for standard contract
documents (hence, contracts that have similar layouts like, NDA, leases, licenses, etc.). Below is a
typical screen shot of some simple configurations.

As an example, the first lone item (in the image below) and titled ‘Audit — Effective Date’ is set
to recognize a Date for ‘Audit’ (excluding the single quotes) Contract Types and extract date
text between the areas that start with ‘Date:’ (excluding the single quotes) and ending with
'Office of the'... It will auto map (if the data is proper) in to the Contract Start/Effective date
(Contract_Start_Date) field.

The forth line item (in the image below) is configured to recognize and extract the Contract
Amount text from a standard Distributor contract (not shown) and extract the date into the
Contract Amount (Contract_Amount) field for Distributor Agreements (contract types) based
on the text found between the starting text of 'not exceed’ (excluding the single quotes) and
ending text of '("Contract Amount”)’ (excluding the single quotes) found in the document.
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Contract Extract Map List

B AddRecord

] - - > [l Page: 1 of 1 Go | Page size: 5 Change Item 1 to 5 of §
For System .
anage ExtraciName 4 For Document Type Area Is Active Start Text End Text
A A A A A A
§ Consulting -
anage  Audit-To tblConfracts 1 lszue to: Expiration Date
Agresment

Consulting

anage | Contract Title tbiContracts 1 Confract Title
Agresment
anage  Counterparty Name Consulfing tblContracts 1 ") and of
fnage = Agreement
SmeEE Distributor Agreement - Contract Consulting tolContracts 1 ot exceed { Conh’cﬂcf
Amount Agresment Amount”)

Your system should be configured by a trained System Administrator and your actual system'’s
configuration will vary (these are only sample serious).

Below are some features that help your team add contracts faster with a file auto-extract
feature. [Note: this feature is not the same as the bulk auto-extract feature that can traverse
through a directory of files in a folder OCR the file and extract text based on rules and auto
import the data into the Enterprise system].  This ‘in-application’ feature is built to help
contract professionals add contracts to the system (on an ongoing basis) faster with an auto
extract feature and when coupled with the existing workflow (field monitoring), the system can
auto validate field and clause data and route workflow tasks based on set conditions).

End-User Use

The 'in-system’ auto extract features helps end-users do their job faster and (coupled with
Workflow Manager) the organization monitor rules around contract data values as contracts
are added to the system. For example, the end-users can use this feature to minimize their
typing for larger volume of standardly formatted contract documents. The organization may
configure “workflow rules” via the Workflow & Alerts Manager [not discussed in this section] to
send automated alerts based on Contract Field values including but not limited to contract
amounts, departments, users, clauses, dates, etc.

In this example, we will use the Distributor Rules (see in the sections above for configuration) to

add a Distributor Contract to the system and let it auto-extract and auto field map several fields
(including the Subject and Start Date and End Date).
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Below is a scaled image of our sample contract with cover page:

CONSULTING AGREEMENT
To: ABC Company Corp
sSubject: Consulting Agmementi

This Consulting Agreement (the "Agreement') 1s made and entered into October 8, 2018
(the "Effective Date") and expires on October 8, 2019 by and between CobbleStone Software, a
5- corporation duly organized under law and having an usual place of business at California

(hereimnafter referred to as the “Company™) and ABC Company with offices (hereinafter referred
to as the "Consultant™).

In the image above, the system has been configured to extract the subject from any text found
between the text ‘Subject.” (without quotes) and the text ‘Thank you for contacting’ (without
text) and map it to the Subject field of the contract record. In addition, on page 3 is the
Effective (Start) Date and the Expiration (End) Date of the agreement. We have configured the
system to extract the Effective Date based on the text found between the ‘effective on’ text and
‘and expires on' text respectively (without quotes); and extract the Expiration date based on the
‘expires on ‘and (“expiration date”)’ text (without quotes).

CONSULTING AGREEMENT

To: ABC Company Corp
Subject: Consulting Agreementi

This Consulting Agreement (the "Agreement”) 1s made and entered into October 8, 2018
(the "Effective Date") and expires on October 8, 2019 by and between CobbleStone Software, a
5- corporation duly organized under law and having an usuval place of business at California
(hereinafter referred to as the “Company™) and ABC Company with offices (hereinafter referred
to as the "Consultant™).

The rules configured for this document type is seen below:
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Contract Extract Map List

B AddRecord

M4 - L Page: 1 of 1 | Go | Page size: 5 Change tem 1 to 5of 5
For System .
anage ExitraciName a For Document Type Area Iz Active Start Text End Text
T T T T T T
. Consulting L

anage  Audit-To = tblContracts 1 lssue to: Expiration Date
Agreement
Consulting .

anage Conifract Title = tbiContracts 1 Contract Title
Agreement

anage  Counterparty Name Consulfing tblContracts 1 "} and of

fndge ® Agreement

bnage Distributor Agreement - Contract Consulting tolContracts . not exceed {"Confrc::f

Amount Agreement Amount”)

After the rules have been configured as per the instructions above, the End-User can now easily
add new contract records with documents and use the auto-extract feature. [We have saved
this file as PDF for example purposes but works equally as well with a Word document.]. In the
image below, we select the "Add Contract from File’ menu from the ‘Contracts’ main menu and
select the Distributor Contract Type and selected the correct PDF file. Next, we select
‘Continue’. [seen below]

Add New Contract Record from File

1. select a type: |Consulting Agresment v

2. select a file: Choose File | Consuliing...ample.docx  file noTes:|

Save and Confinue

Browse to select fle and click Confinue.
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The system will attempt to auto extract text (if the PDF has not been OCRed, it will prompt you

to OCR the file). Next, the system will attempt to auto extract and map fields (seen below):

Add New Consulting Agreement Record

Exfracted text from file: Consuliing Agreement - example.docx

Preview Text Extract

L
CONSULTING AGREEMENT This Consulting Agreement (the "Agreement’] is
made and entered into Cclober 8, 2018 (the "Effective Date”) and expires on
October 8, 2019 by and between CobkleStone Software, a §- corporation duly
organized under law and having an usual place of business at Califernia
{hereinafter referred to as the “Company”) and ABC Company with offices
{hereinafter refemred to as the "Consultant”). WHEREAS, the Company wishes to
engage the Consultant to provide the services described herein and
Consultant agrees fo provide the services for the compensation and otherwise
in may net assigned accordance with the ferms and conditions contained in
this Agreement, NOW THEREFORE, in consideration of the foregoing, and for
other good and valuable consideration, the receipt and sufficiency of which
are hereby acknowledged, accepted and agreed fo, the Company and the
Consultant, intending to ke legally bound, agree to the terms set forth below. 1.
TERM. Commencing as of the Effective Date, and continuing for a period of
Two (2] years (the “Term”], unless eariier terminated pursuant to Article 4 herecf,
the Ceonsultant agrees that he/she will serve as o consultant fo the Company.
This Agreement may be renewed or extended for any period as may be
agreed by the parties. 2, DUTIES AND SERVICES. (a) Consultant's duties and
responsibilities shall be [collectively, the “Duties” or “Services"]. {b) Consultant
agrees that during the Term he/she will devote up to Ten (10] days per menth to
his/her Dutiss. The Company will periedically provide the Consultant with o

— Counterparty Name - Quick Add:

VendorfCustomer|

Name:

Street:

City/State:

Country/Postal

Code:

Sove Company & Refresh | keyed dato below wil need to be re-keyed in

Details

*Contract Title

Consulting Agreement

Type

Consulting Agreement

*Confract Owner

Jones, Bradford

ES ¥ xd: i

Counterparty Name

ABC Company Corp

Typically, the system will auto map the fields, however, a user should review the auto extracted
fields and complete any other required fields, then click the ‘Continue’ button seen above. The

system will save the record, attached the original file and bring the user to Contract Details

Screen (see below). If there are configured Workflow monitoring rules, the workflow engine will
process the Workflow tasks as configured in the Workflow manager (not seen here).
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Contract Details

Details &~

Contract Title Counterparty Name Type

Consulting Agreement ABC Company Corp Consulting Agreement
Contract Owner Department Category

Jones, Bradford Operafions Confidentiality
Descripfion Status

Consultant agrees to provide the services for the Active

compensation and otherwise in may not assigned
accordance with the terms and conditions
contained in this Agreement, NOW THEREFORE, in
consideration of the foregoing, and for other good
and valuable consideration, the receipt and
sufficiency of which are hereby acknowledged,
accepted and agreed to, the Company and the
Consultant, intending to be legally bound, agree
to the terms set forth below
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About CobbleStone

CobbleStone is one of the leading contract management software companies worldwide. We
are best-of-breed company, which means 100% of our efforts are focused on providing better
contract management software to help you manage contracts better. We have been focused
on this goal since 1995. We have thousands of users with over 3 million contracts managed by
Contract Insight®. Leading companies use Contract Insight®.

What Does This Mean to You?

When you select CobbleStone Contract Insight® software to manage your contracts, your
organization will better manage vendor and customer agreements between each party, better
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negotiate renewals, comply with regulatory agencies, and enjoy more time on focusing on your
value to the company and not chasing contracts. To ensure you receive the service you expect,
you are assigned an Account Manager who will know your needs, your business, and help you
get things done. All of our people are in-house and work for CobbleStone; this means you will
receive proactive support and advice. In addition, we provide a great SLA, which means you
are guaranteed a 99.9% per uptime and if things don't work out, we provide you a credit. That
is a product & customer service you can rely on.
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